
~Henri Matisse

Drawing is putting a line round an idea
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Hacking is giving form to an idea
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WHY?
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Hack to Learn
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Hack to Communicate
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Hack to Inspire
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Hack to Inspire
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Hacking Smart Electronics

©2015 bobasoba LLC
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I’m Robert Gallup
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Quick Survey: Coders? 
Designers? 
Strategists? 
Heard of Arduino? 
Hacked Hardware?
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Agenda

Mad Cap Hacks 
Concepts 
LEDs, Buttons, Knobs, Speakers 
Wrap-up
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Tracks
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Off The Rails
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#oscon 

#hackingsmartelectronics 

@robertgallup
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Let’s Get Started!
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EYour Hacker’s Kit

BREADBOARDSTEALTH CASE RESISTOR  LED

SPEA
KER / PIEZO

BUTTON  KNOBJUMPER WIRES TRINKET

XTRA

D
IG

ITA
L LED

PHOTOCELL 
RESISTOR
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Trinket (Adafruit)

Micro-controller
Pins

USB

Reset 
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>Put the Trinket in the Breadboard
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>Connect the Trinket to your Computer (USB)

Glowing at FirstPower Indicator
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>Download Courseware (and unzip)

robertgallup.github.io/get/OSCONCourseware.zip

Handout

Libraries (do not unzip)

Software Setup Guide
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Start Arduino
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>Mac OS X: Security Settings

Open Preferences Unlock, and change 
“Allow apps …” to 
Anywhere

Run IMPORTANT: Reset 
security settings

1 2 3 4

26

>Configure the Board

27

>Configure the Programmer
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>Add the Workshop Examples

1

2 Select HackingSmartElectronics.zip in the Libraries 
folder from the courseware download
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>If it works, …
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?
31

>Load the LEDBlink Example
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>The Sketch Window

Sketch (program)

33

>Run the Sketch on your Trinket

1 2

Press Reset

Press the 
Run button

LED glows
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Wait. What?!
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>The “Blink”

Blinking
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E

//"Setup"runs"once"
void"setup()"{"""""""""""""""""
"pinMode(1,"OUTPUT);"""" //"Pin"#1"is"output""""
}"

//"Loop"repeats"forever"
void"loop()"{"
""digitalWrite(1,"HIGH);""//"turn"the"LED"on"
""delay(500);"""""""""""""//"wait"for"1/2"second"
""digitalWrite(1,"LOW);"""//"turn"the"LED"off"
""delay(500);"""""""""""""//"wait"for"1/2"second"
}

Sketch Structure

Statements

Comment
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(Change the Blinking SpeedHack:

1. Change the blink speed 
Hint: edit the blink sketch to change the blink delay from 1 
second to 1/4 second (note: 1 second = 1000 milliseconds). 
Then run the sketch again. 

2. Use the File > Save command to save your sketch with a 
new name. 

3. STRETCH: Make a short-on, long-off blink  
Hint: the delay times don’t have to be the same.
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Breath.
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EYour First Circuit

Jumper Wire

LED
Resistor

40



>Wire Up an LED

G
N
D 5V

#2
#1
#0
USB

RST
#3
#4
GND
BAT
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EA Note about Breadboards

The “rift” separates the two sides

All of the contact points 
in the same row are 
connected
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(An LED on Another PinHack:

1. Rewire your hack to move the LED to Trinket pin #2. 

2.  In the “blink” sketch, change the LED pin to match. 
Hint: You may have to change more than one line
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qAn LED on Another PinSolution:

//"Setup"runs"once"
void"setup()"{"""""""""""""""""
"pinMode(2,"OUTPUT);"""" //"Pin"#2"is"output""""
}"

//"Loop"repeats"forever"
void"loop()"{"
""digitalWrite(2,"HIGH);""//"turn"the"LED"on"
""delay(1000);""""""""""""//"wait"for"a"second"
""digitalWrite(2,"LOW);"""//"turn"the"LED"off"
""delay(1000);""""""""""""//"wait"for"a"second"
}
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qAnother Way, “Variable”Solution:

//"Declarations"
int"pinLED"="2;"

//"Setup"runs"once"at"the"beginning"
void"setup()"{"""""""""""""""""
""pinMode(pinLED,"OUTPUT);""" " //"Pin"is"output""""
}"

//"Loop"runs"over"and"over"again"forever"
void"loop()"{"
""digitalWrite(pinLED,"HIGH);""" //"turn"the"LED"on"
""delay(1000);""""""""""""" " //"wait"for"a"second"
""digitalWrite(pinLED,"LOW);"""" //"turn"the"LED"off"
""delay(1000);"""""""""""""" " //"wait"for"a"second"
}

pinLED = 2

Declare Variable
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EVariable Declaration

TYPE VALUENAME

int pinLED = 2;
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Libraries Make It Easier
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>Add the BobaBlox Library

1

2 Select BobaBlox.zip in the Libraries folder from the 
courseware download
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>Verify Installation
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>Load and Run the LEDBlinkPin_Blox Example
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EWhat’s Different About This Sketch?

//"Include"the"library"
#include"<BobaBlox.h>"

//"Declarations"
LED"boardLED(1);""""""//"Declare"an"LED"on"pin"#1"

//"Setup"runs"once"
void"setup()"{"""""""""""""""""
}"

//"Use"the"“blink”"method"to"blink"boardLED."Repeat"forever."
void"loop()"{"
"boardLED.blink();"""
}
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ELED Variable Declaration

TYPE PINNAME

LED boardLED(1);
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EUsing a Method

NAME METHOD NAME

boardLED.blink();
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EAnother Version of the Blink Method

# TIMES

boardLED.blink(1, 100);

LENGTH
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(An LED on Any Other Another Pin …Hack:

1. Change the library Blink sketch to use an LED on pin #3 
Hint: You can add a 2nd LED, or move the LED you 
connected in the previous hack.
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(Fast BlinkHack:

1. Change the library sketch to blink faster  
Hint: look at the example of the LED blink method that 
uses two parameters, times and delay.
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EOff The Rails: Examples
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EOff The Rails: Reference
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Breath, again.

59

?
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Of Micro-controllers 
and Electronics

61

EA Microcontroller

microcontroller Input: temperature, motion, touch, …

ACTUATORS

SENSORS

PROGRAM

Output: light, motor, sound, heat, …
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EExperience = Interaction + Algorithm

INTERACTION

ALGORITHM
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EInteraction

Micro-controllers 
sense and control 
voltages on their 
pins.
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Most of us are 
familiar with the 
idea of voltage.

POSITIVE

NEGATIVE
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ETrinket uses 5V power (USB)

+5V (Regulated)

Ground

Ground is zero 
volts. Pins can be 
HIGH (positive) or 
LOW (ground).
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E

CURRENT

Voltage drives current (Positive to zero)

+ -
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EAlternating vs Direct Current

—

+

DC

—

+

AC
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ESome Interesting Facts

Wall

�

Battery

Static

110-240 volts, 15-20 amps

1.5 volts, ~2+ amps

~20,000 volts, ~1 milliamp
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Volts Jolt! Current Kills!
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But, Not Without a Circuit

+

71

+
This is a Schematic
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A Circuit allows current to 
flow from positive to ground

VOLTAGE CURRENT

+
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Circuits use Components

BATTERY

RESISTOR

LED
+
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EComponent: Resistor (Ohms Ω)

+

HEAT

RESISTS CURRENT

+ + +++ +
+

+++
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EComponent: LED (Light Emitting Diode)

CATHODE / -

+

ANODE / +

LIGHT

CONVERTS CURRENT TO LIGHT

-
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E

+5V (Regulated)

0
1
2

Digital I/O

Ground
4
3

LED (Pin 1)

USB

Reset Button 

Power LEDADAFRUIT
TRINKET

The Trinket Basic Connections (pinout)
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More Hacks
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EThe Button (Digital Input)
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E

CONNECTED

1

2

Component: Button

PIN

GND

PIN

GND
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EButton Voltage at Pin

5V

0V

82

EDigital Input

VO
LT

S

A digital input converts voltages above a threshold to HIGH. 
Below the threshold is LOW.

HIGH, LOW, HIGH …PIN SKETCH
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>Wiring Up a Single Button

5V
#2
#1
#0

USB

RST
#3
#4
GND
BAT

G
N

D

PIN
 #2
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(Logic / Reverse LogicHack:

1. Load and run the ButtonLED_Blox sketch. How do you 
think it works? 

2. Reverse the logic in the button sketch (i.e. make the 
LED go OFF when the button is pressed).  
Hint: there are two ways to do this 

3. STRETCH: make the LED blink when the button is 
pressed. Hint: what other LED functions do you have to 
work with?
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EButtonLED Walkthrough

//"Declarations"
LED"boardLED(1);""""""""
Button"pushButton(2);"""

void"setup()"{"""""""""""""""""
}"

void"loop()"{

""
"if"(pushButton.isDown()
" boardLED.on();"
""}"else"{"
"""boardLED.off();
""}

"}"
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EPushbutton Variable Declaration

TYPE PINNAME

Button pushButton(1);

87

EPushbutton isDown Method

NAME METHOD NAME

pushButton.isDown();

88



EOther Pushbutton Methods (true|false)

pushButton.isDown(); 
pushButton.isUp(); 
pushButton.wasPressed(); 
pushButton.wasReleased(); 
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EBranching (One Thing or Another)

if"(pushButton.isDown())"{"
" boardLED.on();"
}"else"{"
""boardLED.off();"
}"
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EThe If statement (if/else)

if"(condition)"{"

"""•••"

}"else"{"
"""•••"

}

if condition is true

if condition is false

 
a 
!a 
a == b 
a <  b 
a >  b 
a != b

CONDITIONS:

91
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EThe Knob (Analog Input)

93

EComponent: Knob (Potentiometer)

+5V

GND

Analog Pin

+5V GND

Analog Pin
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EKnob Voltage at Pin

5V

0V

95

EAnalog to Digital Converter (ADC)

VO
LT

S

An Analog to Digital Converter, translates a voltage into a 
number the sketch can use.

0 … 1023ADCPIN SKETCH
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ETrinket: The Analog Inputs

13
2

ADAFRUIT
TRINKET

Analog Input

97

>Wiring Up a Knob

G
N

D

5V

PIN
 #2

5V
#2
#1
#0

USB

RST
#3
#4
GND
BAT
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(Run the knobDimLED Example Hack:

1. What happens when you turn the knob? 

2. STRETCH: there’s one anomaly with this sketch’s 
behavior (experience). What is it?  
Hint: look at the range of the analogRead() and 
analogWrite() commands in the Arduino reference. 
Those commands are the basis of the knob.value() and 
LED.setBrightness() methods.
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EKnobDimLED Walkthrough

LED"boardLED(1);""""""""
Knob"bluKnob(1);""""""""

int"knobValue;""""""""""

void"setup()"{"""""""""""""""""
}"

void"loop()"{"
"""
""//"Get"the"knob"value"and"use"it"to"set"the"LED"brightness"
""knobValue"="bluKnob.value();"
""boardLED.setBrightness(knobBrightness
"""
}

.setBrightness() method

100



EKnob Variable Declaration

TYPE PINNAME

Knob bluKnob(1);

101

EKnob Value Method

NAME METHOD NAME

bluKnob.value();

102

EKnob Value Method with Range

bluKnob.value(0, 255);

MIN MAX

103

ELED Method to Set Brightness

boardLED.setBrightness(v);

METHOD VALUE 
0-255

LED VARIABLE

NOTE: brightness only works for LEDs connected to a pin supporting analog 
output (see Trinket pinout).
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(Change Knob DirectionHack:

1. Change the direction of the knob (i.e. so the 
brightness goes down when the knob it turned up.)  

2. STRETCH: Change the blink speed in the standard 
blink sketch based on the knob position.
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E

0
1
2

0
1
1

Digital I/O
Analog Output
Analog Input +5V (Regulated)

Ground
4
3 3

2

LED (Pin 1)

USB

Reset Button 

Power LEDADAFRUIT
TRINKET

The Trinket: A More Complete Picture
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ESpeaker (Sound)

PIN

G
N

D

ONE PIN

PIN
1

PIN
2

TWO PINS
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>Wiring Up a Speaker

G
N
D

5V
#2
#1
#0
USB

RST
#3
#4
GND
BAT
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(Run the Speaker ExampleHack:

1. After wiring the Speaker up, load and run the 
Speaker sketch. 

2. Change the pitch of the speaker  
3. Make two beeps of different pitches each time 

through the loop
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ESpeaker Sketch Walkthrough

Speaker"piezo(2);"""""""" "

void"setup()"{"""""""""""""""""
}"

void"loop()"{"
"""
""piezo.beep(1000,"200);" "
""delay"(100);"
"""
}"
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ESpeaker Variable Declaration

TYPE PINNAME

Speaker piezo(2);

112



ESpeaker beep Method

NAME METHOD 
NAME

piezo.beep(1000, 200);

FREQUENCY DURATION

113

(Run the SpeakerPitch SketchHack:

1. Load and run the SpeakerPitch sketch. 

2. The For{} statement creates a loop within a loop. Look up 
the command in the Arduino reference. 

3. Change pitch steps to 100Hz each, rather than 50. 

4. STRETCH: Change the pitch step to be 10% each time 
rather than a fixed number. 
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(More Speaker HacksHack:

1. BIG STRETCH: See if you can figure out how to control 
the pitch with a knob. 

2. GIANT STRETCH: Wire up a button and use it to create a 
sound each time it is released. Create a sound with 
personality. 

115

?
116



Wax On. Wax Off.
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LED

118

Button

119

Knob

120



Speaker
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Wrap Up
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EMany Other Platforms

RPi BeagleBoneArduino

spark.io

pinocc.io

teensy
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EAdd-On Boards (Shields)
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Next Steps
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EBonus Material (End of these slides)

XTRA

Digital LED 
Photocell 
Trinket @ 16MHz 
Resistor Values
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EOnline Tutorials

http://arduino.cc/en/Tutorial 
http://playground.arduino.cc 
https://learn.sparkfun.com 

https://learn.adafruit.com 
https://learn.adafruit.com/introducing-trinket 

google “arduino tutorials” 
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EOnline Resources

ARDUINO: www.arduino.cc, reference, tutorials 
SPARKFUN: www.sparkfun.com, components, devices, tutorials 
ADAFRUIT: www.adafruit.com, components, devices, tutorials 
MAKE MAGAZINE: www.makezine.com, magazine, books, stuff 
MAKER SHED: www.makershed.com, components, kits, stuff 
INSTRUCTABLES: www.instructables.com, tutorials 
AMAZON: www.amazon.com, books, components, devices, tutorials 
O’REILLY: www.oreilly.com, books, tutorials, etc. 

ELECTRONIC GOLDMINE: http://www.goldmine-elec-products.com, components  
JAMECO: www.jameco.com, components  
MOUSER: www.mouser.com, components 
DIGIKEY: www.digikey.com, components
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Thank You!
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Robert Gallup   bob@robertgallup.com   @robertgallup
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XTRA
Digital LED 
Photocell 
Trinket @ 16MHz 
Resistor Values
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>The XTRA Sketches

132



DIGITAL LED

133

EThe Smart LED (Digital LED)

Unlike a standard LED, the Smart LED has a small processor inside that 
controls the light and communicates digitally with your microprocessor. They 
are also called NeoPixels. Generically, they are sometimes referred to by their 
“controller”, the WS2812 or WS2811.
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EComponent: Smart LED (NeoPixel)

D
ig

ital In
+

5
V

G
N

D
D

ig
ital O

u
t

0 1 2 3 4 5 6 7

Digital In

Multiple Smart LEDs can be “cascaded” from a 
singe pin on your microprocessor (but, you may 
need additional power).
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>Wiring Up a Smart LED (NeoPixel)

5V
#2
#1
#0

USB

RST
#3
#4
GND
BAT

G
N

D

5V

PIN
 #2
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(Install and Verify the LibraryHack:

1. Install the Adafruit_NeoPixel.zip library using the menu 
Sketch > Include Library > Add .ZIP Library… 

2. Verify that Adafruit_NeoPixel appears under Examples in 
the File menu.
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(The SmartPixel ExampleHack:

1. After wiring the SmartPixel up and installing the library, 
load and run the SmartPixel sketch in the XTRA examples. 

2. Change the rate the colors change in the sketch 

3. The sketch currently uses red, green, and blue as it’s 
colors. Change to three different colors  
Hint: look at the comments to figure out the parameters for 
the setPixelColor() method.
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(The SmartPixelRainbow SketchHack:

1. Load and run the SmartPixelRainbow sketch. 

2. Change the rate the colors change in the sketch.  
Hint: You can guess what to do (perfectly respectable), or look 
at the more complicated code in the NeoPixelFunctions tab 
for a clue (your sketch can have multiple tabs, BTW). 

3. BIG STRETCH: See if you can figure out how to control the 
rainbow color with a knob. 
Hint: look at the setPixelColor() and wheel() methods. 
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PHOTOCELL

140



EPhotocell (Light Dependent Resistor)

A photocell changes its resistance depending on the amount of light that falls 
on it. As the light increases, the resistance decreases. Combined with another 
fixed resistor, it acts very much like a knob.
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EComponent: Photocell

+5V

GND

ANALO
G

 PIN

+5V GND

1K RESISTOR

ANALOG PIN
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EPhotocell Voltage at Pin

5V

0V

DARK LIGHT
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>Wiring Up a Photocell

PIN
 #2

G
N

D

5V
#2
#1
#0

USB

RST
#3
#4
GND
BAT
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EPhotocell Declaration

TYPE PIN*NAME

Photocell cell(1);

* The photocell is an analog device. So, the pin is an analog pin. Analog pin #1 
is *physical* pin #2.
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EPhotocell Value Method

NAME METHOD NAME

cell.value();

146

EPhotocell Value Method with Range

cell.value(0, 255);

MIN MAX

147

(Run the PhotocellBlink sketchHack:

1. Build the photocell circuit and run the PhotocellBlink 
sketch from the XTRA workshop examples. What happens 
when you vary the light on the photocell? 

2. Reverse the logic of the photocell (i.e. so the LED blink 
rate goes up when the light on the cell goes up.) 

3. BIG STRETCH: write a speaker sketch that changes tone 
with the light on the photocell.
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TRINKET @ 16 MHz
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EThe Trinket Can Go Faster (16 MHz)

By default, the Trinket has a clock that runs at 8 MHz (megahertz). But, the 5V Trinket is capable of 
running twice as fast at 16 MHz. Follow the steps below to run your Trinket at 16 MHz. (More 
information can be found at https://learn.adafruit.com/introducing-trinket/16mhz-vs-8mhz-clock.) 

1. At the beginning of your sketch, include: 
#include <avr/power.h> 

2. In the Setup function, include: 
if (F_CPU == 16000000) clock_prescale_set(clock_div_1); 

3. Choose Tools > Board > Adafruit Trinket 16 MHz 

4. The XTRA example, SpeakerRandomBeep_16MHZ 
demonstrates this technique.
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RESISTOR VALUES
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EIdentifying Resistor Values

Resistor values (ohms) are identified by colored bands 
painted around their body. The colors represent two digits 
followed by a multiplier. So, for example, the illustration above 
has a first digit=0 (black), the second digit=1 (brown), and the 
multiplier is x1000 (orange, 103). So the value is 01 x 1000 = 
1000 ohms. The tolerance is indicated by the fourth band. It 
will be gold (±5%) or silver (±10%) for typical applications. 

TOLERANCE

MULTIPLIER

SECOND DIGIT

FIRST DIGIT

BLACK

BROWN

RED

ORANGE

YELLOW

GREEN

BLUE

VIOLET

GRAY

WHITE

GOLD

SILVER

COLOR

0

1

2

3

4

5

6

7

8

9

DIGIT 1

0

1

2

3

4

5

6

7

8

9

DIGIT 2

x100

x101

x102

x103

x104

x105

x106

x107

x108

x109

x0.1

x0.01

MULTIPLIER

0

±1%

±2%

±0.5%

±0.25%

±0.1%

±0.05%

±5%

±10%

TOLERANCE

-NONE- 9 ±20%
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ROBERT GALLUP 
bob@robertgallup.com 

@robertgallup
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